This tutorial describes the construction of an excavation pit in soft clay and sand layers. The pit is a relatively small excavation of 12 by 20 m, excavated to a depth of 6.5 m below the surface. Struts, walings and ground anchors are used to prevent the pit from collapsing. After the full excavation, an additional surface load is added on one side of the pit.

Figure 2.1 Top view of the excavation pit

The proposed geometry for this exercise is 80 m wide and 50 m long, as shown in Figure 2.1. The excavation pit is placed in the center of the geometry. Figure 2.2 shows a cross section of the excavation pit with the soil layers. The clay layer is considered to be impermeable.

Objectives:

• Using the Hardening Soil model
• Modelling of ground anchors
• Using interface features
• Defining over-consolidation ratio (OCR)
• Prestressing a ground anchor
• Changing water conditions
• Selection of stress points to generate stress/strain curves
• Viewing plastic points
2.1 GEOMETRY

To create the geometry model, follow these steps:

Project properties
• Start a new project.
• Enter an appropriate title for the project.
• Define the limits for the soil contour as \( x_{\text{min}} = 0, \ x_{\text{max}} = 80, \ y_{\text{min}} = 0 \) and \( y_{\text{max}} = 50 \).

2.1.1 DEFINITION OF SOIL STRATIGRAPHY

In order to define the soil layers, a borehole needs to be added and material properties must be assigned. As all soil layers are horizontal, only a single borehole is needed.

Create a borehole at \((0 \ 0 \ 0)\). The Modify soil layers window pops up.
• Add 4 layers with bottom levels at \(-1, \ -9.5, \ -11, \ -20\). Set the Head in the borehole column to \(-4\ m\).

Open the Material sets window.
• Create a new data set under Soil and interfaces set type.
• Identify the new data set as "Fill".
• From the Material model drop-down menu, select Hardening Soil model. In contrast with the Mohr-Coulomb model, the Hardening Soil model takes into account the difference in stiffness between virgin-loading and unloading-reloading. For a detailed description of the Hardening Soil model, see the Chapter 6 in the Material Models Manual.
• Define the saturated and unsaturated unit weights according to Table 2.1.
• In the Parameters tabsheet, enter values for \( E_{\text{so50}}^{\text{ref}}, E_{\text{oed}}^{\text{ref}}, E_{\text{ur}}^{\text{ref}}, m, c'_{\text{ref}}, \varphi'_{\text{ref}}, \psi' \) and \( \nu'_{\text{ur}} \) according to Table 2.1. Note that Poisson’s ratio is an advanced parameter.
• As no consolidation will be considered in this exercise, the permeability of the soil will not influence the results. Therefore, the default values can be kept in the Flow parameters tabsheet.
Table 2.1 Material properties for the soil layers

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Fill</th>
<th>Sand</th>
<th>Soft Clay</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Material model</td>
<td>Model</td>
<td>Hardening Soil model</td>
<td>Hardening Soil model</td>
<td>Hardening Soil model</td>
<td>–</td>
</tr>
<tr>
<td>Drainage type</td>
<td>Type</td>
<td>Drained</td>
<td>Drained</td>
<td>Undrained A</td>
<td>–</td>
</tr>
<tr>
<td>Unit weight above phreatic level</td>
<td>( \gamma_{\text{unsat}} )</td>
<td>16.0</td>
<td>17.0</td>
<td>16.0</td>
<td>kN/m(^3)</td>
</tr>
<tr>
<td>Unit weight below phreatic level</td>
<td>( \gamma_{\text{sat}} )</td>
<td>20.0</td>
<td>20.0</td>
<td>17.0</td>
<td>kN/m(^3)</td>
</tr>
<tr>
<td><strong>Parameters</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secant stiffness for CD triaxial test</td>
<td>( E_{\text{sec}}^{\text{ref}} )</td>
<td>2.2 \cdot 10^4</td>
<td>4.3 \cdot 10^4</td>
<td>2.0 \cdot 10^3</td>
<td>kN/m(^2)</td>
</tr>
<tr>
<td>Tangent oedometer stiffness</td>
<td>( E_{\text{t}}^{\text{ref}} )</td>
<td>2.2 \cdot 10^4</td>
<td>2.2 \cdot 10^4</td>
<td>2.0 \cdot 10^3</td>
<td>kN/m(^2)</td>
</tr>
<tr>
<td>Unloading/reloading stiffness</td>
<td>( m )</td>
<td>0.5</td>
<td>0.5</td>
<td>1.0</td>
<td>–</td>
</tr>
<tr>
<td>Power for stress level dependency of stiffness</td>
<td>( c'_{\text{ref}} )</td>
<td>1</td>
<td>1</td>
<td>5</td>
<td>kN/m(^2)</td>
</tr>
<tr>
<td>Cohesion</td>
<td>( \varphi'_{\text{ref}} )</td>
<td>30.0</td>
<td>34.0</td>
<td>25.0</td>
<td>°</td>
</tr>
<tr>
<td>Friction angle</td>
<td>( \psi_{\text{ur}} )</td>
<td>0.0</td>
<td>4.0</td>
<td>0.0</td>
<td>°</td>
</tr>
<tr>
<td>Dilatancy angle</td>
<td>( \nu_{\text{ur}}' )</td>
<td>0.2</td>
<td>0.2</td>
<td>0.2</td>
<td>–</td>
</tr>
<tr>
<td>Interfaces</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interface reduction factor</td>
<td>( R_{\text{inter}} )</td>
<td>0.65</td>
<td>0.7</td>
<td>0.5</td>
<td>–</td>
</tr>
<tr>
<td><strong>Initial</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>( K_0 ) determination</td>
<td>–</td>
<td>Automatic</td>
<td>Automatic</td>
<td>Automatic</td>
<td>–</td>
</tr>
<tr>
<td>Lateral earth pressure coefficient</td>
<td>( K_o )</td>
<td>0.5000</td>
<td>0.4408</td>
<td>0.7411</td>
<td>–</td>
</tr>
<tr>
<td>Over-consolidation ratio</td>
<td>( OCR )</td>
<td>1.0</td>
<td>1.0</td>
<td>1.5</td>
<td>–</td>
</tr>
<tr>
<td>Pre-overburden pressure</td>
<td>( POP )</td>
<td>0.0</td>
<td>0.0</td>
<td>0.0</td>
<td>–</td>
</tr>
</tbody>
</table>

- In the *Interfaces* tabsheet, select *Manual* in the *Strength* box and enter a value of 0.65 for the parameter \( R_{\text{inter}} \). This parameter relates the strength of the interfaces to the strength of the soil, according to the equations:

  \[
  c_i = R_{\text{inter}} c_{\text{soil}} \quad \text{and} \quad \tan\varphi_i = R_{\text{inter}} \tan\varphi_{\text{soil}} \leq \tan\varphi_{\text{soil}}
  \]

  Hence, using the entered \( R_{\text{inter}} \)-value gives a reduced interface friction and interface cohesion (adhesion) compared to the friction angle and the cohesion in the adjacent soil.

  **Hint:** When the *Rigid* option is selected in the *Strength* drop-down, the interface has the same strength properties as the soil (\( R_{\text{inter}} = 1.0 \)).

  Note that a value of \( R_{\text{inter}} < 1.0 \), reduces the strength as well as the stiffness of the interface (Section 6.1.5 of the Reference Manual).

- In the *Initial* tabsheet, define the *OCR*-value according to Table 2.1.
- Click *OK* to close the window.
- In the same way, define the material properties of the "Sand" and "Soft Clay" materials as given by Table 2.1.
- After closing the *Material sets* window, click the *OK* button to close the *Modify soil layers* window.
- In the *Soil* mode right click on the upper soil layer. In the appearing right hand
mouse button menu, select the *Fill* option in the *Set material* menu.

- In the same way assign the *Soft Clay* material to the soil layer between \( y = -9.5 \) m and \( y = -11.0 \) m.
- Assign the *Sand* material to the remaining two soil layers.
- Proceed to the *Structures* mode to define the structural elements.

**Hint:** The *Tension cut-off* option is activated by default at a value of 0 \( kN/m^2 \). This option is found in the *Advanced* options on the *Parameters* tabsheet of the *Soil* window. Here the *Tension cut-off* value can be changed or the option can be deactivated entirely.

### 2.1.2 DEFINITION OF STRUCTURAL ELEMENTS

The creation of sheet pile walls, walings, struts and surface loads and ground anchors is described below.

- Create a surface between \((30 \ 20 \ 0), (30 \ 32 \ 0), (50 \ 32 \ 0)\) and \((50 \ 20 \ 0)\).
- Extrude the surface to \( z = -1 \), \( z = -6.5 \) and \( z = -11 \).
- Right-click on the deepest created volume (between \( z = 0 \) and \( z = -11 \)) and select the *Decompose into surfaces* option from the appearing menu.
- Delete the top surfaces (2 surfaces). An extra surface is created as the volume is decomposed.
- Hide the excavation volumes (do not delete). The eye button in the *Model explorer* and the *Selection explorer* trees can be used to hide parts of the model and simplify the view. A hidden project entity is indicated by a closed eye.
- Click the *Create structure* button.
- Create beams (walings) around the excavation circumference at level \( z = -1 m \).
  - Press the <Shift> key and keep it pressed while moving the mouse cursor in the -z-direction. Stop moving the mouse as the z-coordinate of the mouse cursor is \(-1\) in the cursor position indicator. Note that as you release the <Shift> key, the z-coordinate of the cursor location does not change. This is an indication that you can draw only on the xy-plane located at \( z = -1 \).
  - Click on \((30 \ 20 \ -1), (30 \ 32 \ -1), (50 \ 32 \ -1), (50 \ 20 \ -1), (30 \ 20 \ -1)\) to draw the walings.
  - Click on the right mouse button to stop drawing walings.
- Create a beam (strut) between \((35 \ 20 \ -1)\) and \((35 \ 32 \ -1)\). Press <Esc> to end defining the strut.
- Create data sets for the walings and strut according to Table 2.2 and assign the materials accordingly.
- Copy the strut into a total of three struts at \( x = 35 \) (existing), \( x = 40 \), and \( x = 45 \).
Table 2.2 Material properties for the beams

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Strut</th>
<th>Waling</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material type</td>
<td>Type</td>
<td>Elastic</td>
<td>Elastic</td>
<td>--</td>
</tr>
<tr>
<td>Young's modulus</td>
<td>$E$</td>
<td>$2.1 \cdot 10^8$</td>
<td>$2.1 \cdot 10^8$</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Unit weight</td>
<td>$\gamma$</td>
<td>78.5</td>
<td>78.5</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Cross section area</td>
<td>$A$</td>
<td>$0.007367$</td>
<td>$0.008682$</td>
<td>m²</td>
</tr>
<tr>
<td>Moment of Inertia</td>
<td>$I_x$</td>
<td>$5.073 \cdot 10^{-5}$</td>
<td>$3.66 \cdot 10^{-4}$</td>
<td>m⁴</td>
</tr>
<tr>
<td></td>
<td>$I_y$</td>
<td>$5.073 \cdot 10^{-5}$</td>
<td>$1.045 \cdot 10^{-4}$</td>
<td>m⁴</td>
</tr>
</tbody>
</table>

Modelling ground anchors

In PLAXIS 3D ground anchors can be modelled using the *Node-to-node anchor* and the *Embedded beam* options as described in the following:

1. First the ungrouted part of the anchor is created using the *Node-to-node anchor* feature. Start creating a node-to-node anchor by selecting the corresponding button in the options displayed as you click on the *Create structure* button.

2. Click on the command line and type “30 24 -1 21 24 -7”. Press <Enter> and <Esc> to create the ungrouted part of the first ground anchor.

3. Create a node-to-node anchor between the points (50 24 -1) and (59 24 -7).

The grouted part of the anchor is created using the *Embedded beam* option. Create embedded beams between (21 24 -7) and (18 24 -9) and between (59 24 -7) and (62 24 -9). Set the *Behaviour* to *Grout body* (Section 5.6.4 of the Reference Manual).

Create a data set for the embedded beam and a data set for the node-to-node anchor according to Table 2.3 and Table 2.4 respectively. Assign the data sets to the node-to-node anchors and to the embedded beams.

Table 2.3 Material properties for the node-to-node anchors

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Node-to-node anchor</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material type</td>
<td>Type</td>
<td>Elastic</td>
<td>--</td>
</tr>
<tr>
<td>Axial stiffness</td>
<td>$E_A$</td>
<td>$6.5 \cdot 10^5$</td>
<td>kN</td>
</tr>
</tbody>
</table>

Table 2.4 Material properties for the embedded beams (grout body)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Grout</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Young's modulus</td>
<td>$E$</td>
<td>$3 \cdot 10^7$</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Unit weight</td>
<td>$\gamma$</td>
<td>24</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Beam type</td>
<td></td>
<td><em>Predefined</em></td>
<td>--</td>
</tr>
<tr>
<td>Predefined beam type</td>
<td></td>
<td><em>Massive circular beam</em></td>
<td>--</td>
</tr>
<tr>
<td>Diameter</td>
<td>$Diameter$</td>
<td>0.14</td>
<td>m</td>
</tr>
<tr>
<td>Axial skin resistance</td>
<td>$Type$</td>
<td><em>Linear</em></td>
<td>--</td>
</tr>
<tr>
<td>Skin resistance at the top of the</td>
<td>$T_{\text{skin, start, max}}$</td>
<td>200</td>
<td>kN/m</td>
</tr>
<tr>
<td>embedded beam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skin resistance at the bottom of the</td>
<td>$T_{\text{skin, end, max}}$</td>
<td>0.0</td>
<td>kN/m</td>
</tr>
<tr>
<td>embedded beam</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Base resistance</td>
<td>$F_{\text{max}}$</td>
<td>0.0</td>
<td>kN</td>
</tr>
</tbody>
</table>

**Hint:** The colour indicating the material set assigned to the entities in project can be changed by clicking on the *Colour* box of the selected material set and selecting a colour from the *Colour* part of the window.
The remaining grouted anchors will be created by copying the defined grouted anchor.

Click on the **Select** button and click on all the elements composing both of the ground anchors keeping the <Ctrl> key pressed.

Use the **Create array** function to copy both ground anchors (2 embedded beams + 2 node-to-node anchors) into a total of 4 complete ground anchors located at \( y = 24 \) and \( y = 28 \) by selection the **1D, in y direction** option in the **Shape** drop-down menu and define the **Distance between columns** as 4 m.

Multi-select all parts of the ground anchors (8 entities in total). While all parts are selected and the <Ctrl> key is pressed, click the right mouse button and select the **Group** from the appearing menu.

In the **Model explorer** tree, expand the **Groups** subtree by clicking on the (+) in front of the groups.

- Click the **Group_1** and rename it to "GroundAnchors".

**Hint:** The name of the entities in the project should not contain any space or special character except "_".

To define the sheet pile walls and the corresponding interfaces, follow these steps:

Select all four vertical surfaces created as the volume was decomposed. Keeping the <Ctrl> key pressed, click the right mouse button and select the **Create plate** option from the appearing menu.

Create a data set for the sheet pile walls (plates) according to Table 2.5. Assign the data sets to the four walls.

- As all the surfaces are selected, assign both positive and negative interfaces to them using the options in the right mouse button menu.

**Hint:** The term 'positive' or 'negative' for interfaces has no physical meaning. It only enables distinguishing between interfaces at each side of a surface.

### Table 2.5 Material properties of the sheet pile walls

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Name</th>
<th>Sheet pile wall</th>
<th>Unit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of behaviour</td>
<td>Type</td>
<td>Elastic, non-isotropic</td>
<td>–</td>
</tr>
<tr>
<td>Thickness</td>
<td>( d )</td>
<td>0.379</td>
<td>m</td>
</tr>
<tr>
<td>Weight</td>
<td>( \gamma )</td>
<td>2.55</td>
<td>kN/m³</td>
</tr>
<tr>
<td>Young’s modulus</td>
<td>( E_1 )</td>
<td>( 1.46 \cdot 10^7 )</td>
<td>kN/m²</td>
</tr>
<tr>
<td></td>
<td>( E_2 )</td>
<td>( 7.3 \cdot 10^5 )</td>
<td>kN/m²</td>
</tr>
<tr>
<td>Poisson’s ratio</td>
<td>( \nu_{12} )</td>
<td>0.0</td>
<td>–</td>
</tr>
<tr>
<td>Shear modulus</td>
<td>( G_{12} )</td>
<td>( 7.3 \cdot 10^5 )</td>
<td>kN/m²</td>
</tr>
<tr>
<td></td>
<td>( G_{13} )</td>
<td>( 1.27 \cdot 10^5 )</td>
<td>kN/m²</td>
</tr>
<tr>
<td></td>
<td>( G_{23} )</td>
<td>( 3.82 \cdot 10^5 )</td>
<td>kN/m²</td>
</tr>
</tbody>
</table>

Non-isotropic (different stiffnesses in two directions) sheet pile walls are defined. The local axis should point in the correct direction (which defines which is the 'stiff' or the 'soft' direction). As the vertical direction is generally the stiffest direction in sheet pile walls,
local axis 1 shall point in the z-direction.

In the Model explorer tree expand the Surfaces subtree, set AxisFunction to Manual and set Axis1_z to −1. Do this for all the pile wall surfaces.

Create a surface load defined by the points: (34 19 0), (41 19 0), (41 12 0), (34 12 0). The geometry is now completely defined.

Hint: The first local axis is indicated by a red arrow, the second local axis is indicated by a green arrow and the third axis is indicated by a blue arrow. More information related to the local axes of plates is given in the Reference Manual.

2.2 MESH GENERATION

- Click on the Mesh tab to proceed to the Mesh mode.
- Select the surface representing the excavation. In the Selection explorer set the value of Coarseness factor to 0.25.
- Set the element distribution to Coarse. Uncheck the box for Enhanced mesh refinements. Generate the mesh.
- View the mesh. Hide the soil in the model to view the embedded beams.
- Click on the Close tab to close the Output program and go back to the Mesh mode of the Input program.

Hint: The Enhanced mesh refinements are automatically used in mesh generation. More information is available in Section 7.1.3 of Reference Manual.

2.3 PERFORMING CALCULATIONS

The calculation consists of 6 phases. The initial phase consists of the generation of the initial stresses using the K0 procedure. The next phase consists of the installation of the sheet piles and a first excavation. Then the walings and struts will be installed. In phase 3, the ground anchors will be activated and prestressed. Further excavation will be performed in the phase after that. The last phase will be the application of the additional load next to the pit.

- Click on the Staged construction tab to proceed with definition of the calculation phases.
- The initial phase has already been introduced. Keep its calculation type as K0 procedure. Make sure all the soil volumes are active and all the structural elements are inactive.
- Add a new phase (Phase_1). The default values of the parameters will be used for
this calculation phase.

- Deactivate the first excavation volume (from $z = 0$ to $z = -1$).
- In the Model explorer, activate all plates and interfaces by clicking on the checkbox in front of them. The active elements in the project are indicated by a green check mark in the Model explorer.

Add a new phase (Phase_2). The default values of the parameters will be used for this calculation phase.

- In the Model explorer activate all the beams.  
- Add a new phase (Phase_3). The default values of the parameters will be used for this calculation phase.
- In the Model explorer activate the GroundAnchors group. 
- Select one of the node-to-node anchors. 
- In the Selection explorer expand the node-to node anchor features.
  - Click on the Adjust prestress checkbox. Enter a prestress force of 200 kN (Figure 2.3).
  - Do the same for all the other node-to-node anchors.

![Figure 2.3 Node-to-node anchor in the Selection explorer](image)

Add another phase (Phase_4). The default values of the parameters will be used for this calculation phase.

- Select the soil volume to be excavated in this phase (between $z = -1$ and $z = -6.5$).
- In the Selection explorer under WaterConditions feature, click on the Conditions and select the Dry option from the drop-down menu.

![Figure 2.4 Water conditions in the Selection explorer](image)

- Deactivate the volume to be excavated (between $z = -1$ and $z = -6.5$).
• Hide the soil and the plates around the excavation.
• Select the soil volume below the excavation (between \( z = -6.5 \) and \( z = -9.5 \)).
  In Selection explorer under WaterConditions feature,
  • click Conditions and select Head from the drop-down menu. Enter \( z_{\text{ref}} = -6.5 \) m.
  Select the soft clay volume below the excavation.
  • Set the water conditions to Interpolate.
  Preview this calculation phase.
  Click the Vertical cross section button in the Preview window and define the cross section by drawing a line across the excavation.
  • Select the \( p_{\text{steady}} \) option from the Stresses menu.

**Hint:** Hold <Shift> key when drawing to get a straight line.

Display the contour lines for steady pore pressure distribution. Make sure that the Legend option is checked in View menu. The steady state pore pressure distribution is displayed in Figure 2.5. Scroll the wheel button of the mouse to zoom in or out to get a better view.

• Change the legend settings to:
  • Scaling: manual
  • Minimum value: 0
  • Number of intervals: 18

![Figure 2.5 Preview of the steady state pore pressures in Phase_4 in a cross section](image)

• Click on the Close button to return to the Input program.

Add another phase (Phase_5). The default values of the parameters will be used for this calculation phase.

• Activate the surface load and set \( \sigma_z = -20 \text{ kN/m}^2 \).
**Defining points for curves**

Before starting the calculation process, some stress points next to the excavation pit and loading are selected to plot a stress strain curve later on.

- Click the *Select points for curves* button. The model and *Select points* window will be displayed in the Output program.
  - Define (37.5 19 -1.5) as *Point-of-interest coordinates*.

**Hint:** The visualization settings can be changed from the menu. For more information refer Section 8.5.2 of Reference Manual.

- Click the *Search closest* button. The number of the closest node and stress point will be displayed.
- Click the checkbox in front of the stress point to be selected. The selected stress point will be shown in the list.
- Select also stress points near the coordinates (37.5 19 -5), (37.5 19 -6) and (37.5 19 -7) and close the *Select points* window.
- Click the *Update* button to close the Output program.

Start the calculation process.

**Hint:** Instead of selecting nodes or stress points for curves before starting the calculation, points can also be selected after the calculation when viewing the output results. However, the curves will be less accurate since only the results of the saved calculation steps will be considered.

» To plot curves of structural forces, nodes can only be selected after the calculation.

» Nodes or stress points can be selected by just clicking them. When moving the mouse, the exact coordinates of the position are given in the cursor location indicator bar at the bottom of the window.

### 2.4 VIEWING THE RESULTS

After the calculations, the results of the excavation can be viewed by selecting a calculation phase from the *Phases* tree and pressing the *View calculation results* button.

Select the final calculation phase (Phase_5) and click the *View calculation results* button. The Output program will open and will show the deformed mesh at the end of the last phase.

- The stresses, deformations and three dimensional geometry can be viewed by selecting the desired output from the corresponding menus. For example, choose *Plastic points* from the *Stresses* menu to investigate the plastic points in the model.
• In the *Plastic points* window, Figure 2.6, select all the options except the *Elastic points* and the *Show only inaccurate points* options. Figure 2.7 shows the plastic points generated in the model at the end of the final calculation phase.

![Plastic points window](image)

**Figure 2.6 Plastic points window**

![Plastic points at the end of the final phase](image)

**Figure 2.7 Plastic points at the end of the final phase**

The graph will now show the major principal strain against the major principal stress. Both values are zero at the beginning of the initial conditions. After generation of the initial conditions, the principal strain is still zero whereas the principal stress is not zero anymore. To plot the curves of all selected stress points in one graph, follow these steps:

• Select *Add curve → From current project* from right mouse button menu.
• Generate curves for the three remaining stress nodes in the same way.

The graph will now show the stress-strain curves of all four stress points (Figure 2.9). To see information about the markers, make sure the *Value indication* option is selected from the *View* menu and hold the mouse on a marker for a while. Information about the coordinates in the graph, the number of the point in the graph, the number of the phase and the number of the step is given. Especially the lower stress points show a considerable increase in the stress when the load is applied in the last phase.

To create a stress path plot for stress node \((37.519 − 1.5)\) follow these steps:

• Create a new chart.
**Figure 2.8 Curve generation window**

**Figure 2.9 Stress - Strain curve**

**Hint:** To re-enter the Curve generation window (in the case of a mistake, a desired regeneration or a modification), the Curve settings option from the Format menu can be selected. As a result the Curves settings window appears, on which the Regenerate button should be clicked.

The Chart settings option in the Format menu may be used to modify the settings of the chart.

- In the Curves generation window, select node (37.519 – 1.5) from the drop-down menu of the $x$–axis of the graph and $\sigma_y'$ under Cartesian effective stresses.
- Select node (37.519 – 1.5) from the drop-down menu of the $y$–axis of the graph. Select $\sigma_z'$ under Cartesian effective stresses.
- Click OK to confirm the input (Figure 2.10).
Figure 2.10  Vertical effective stress ($\sigma_z$) versus horizontal effective stress ($\sigma_y$) at stress node located near (37.5 19 -1.5)